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1. Wireless Sensor Network Overview

The LORD MicroStrain® Wireless Sensor Network is a high- speed, scalable, sensor data
acquisition and sensor networking system. Each system consists of wireless sensor interface
nodes, a data collection gateway, and full-featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS®) data communications protocol.
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration from up to two kilometers away. Gateways can be connected locally to
a host computer or remotely via local and mobile networks. Some gateways also feature analog
outputs for porting sensor data directly to standalone data acquisition equipment.

P
0=
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»

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4-compliant and include lossless synchronized sampling, continuous and burst sampling,
and data logging. A single gateway can coordinate many nodes of any type, and multiple gateways
can be managed from one computer with the Node Commander® and SensorCloud™ software
platforms. Integration to customer systems can be accomplished using OEM versions of the
sensor nodes and leveraging the LORD MicroStrain® data communications protocol.

Common wireless applications of LORD MicroStrain® Sensing Systems are strain sensor
measurement, accelerometer platforms, vibration monitoring, energy monitoring, environmental
monitoring, and temperature monitoring.

%4 LORD MicroStrain
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2. Node Overview

The G-Link®-LXRS® wireless sensor node features two integrated high-speed + 2 gor+ 10 g
micro-electro- mechanical (MEMS) accelerometers and an internal temperature sensor. The
combined readings from the accelerometers produce a triaxial acceleration output. The node has
12-bit resolution with a measurement bandwidth of 0 to 500 Hz. The node can log data to internal
memory and transmit real-time, synchronized data at a wide range of sample rates and intervals.

To acquire sensor data, the G-Link -LXRS is used with a LORD MicroStrain data gateway such as
the WSDA®-Base or WSDA® -1500 - LXRS®.

Figure 1 - G-Link®-LXRS® Wireless Accelerometer Node
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21 Components List

The G-Link®-LXRS® sensors and antenna are integrated so there are no external components
or removable parts. The node requires a power supply for charging the internal battery and is
purchased separately. For a complete list of available configurations, accessories, additional
system products and ordering information see Parts and Configurations on page 54.

LORD MicroStrain®
G-Link® -LXRs®

Wireless Accelerometer Node

patent pending .

#6305-

1
4220 01078 3&—.2

T A h ¢

ltem Description ‘ Quantity
A | G-Link®-LXRS® Wireless Accelerometer Node 1
- Charging power supply with plug adapter kit (optional) 1
-- User Manual, Quick Start Guide and Calibration Certificate 1

Table 1 - Node Components List
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2.2 Interface and Indicators

The G-Link®-LXRS® includes a power input jack for charging the internal battery or externally
powering the node, a power on/off switch, a power source selector switch, and mounting holes
for device installation. The radio frequency (RF) antenna is internal to the node.

The indicators on the G-Link®-LXRS® include a device status indicator, a battery charging
indicator, a completed charge indicator, and a charge source indicator. The following table
describes basic indicator behavior. During data acquisition, the device status indicator has
other sequences (see Device Status Indicators on page 48).

device information label
(including orientation)

_ t* : mounting holes

indicators / \ _\
8

/

power source
switch

ON/OFF
switch

power jack BOTTOM VIEW

Figure 2 - Interface and Indicators

Indicator Symbol Behavior ‘ Node Status
Battery charge OFF No power source detected
source indicator ON green Charging source detected
Battery charging OFF Node not charging
indicator ON bright red Node battery charging

OFF Node charge status unknown
Completed
charge indicator ON green Battery fully charged
Device status OFF_ . Node OFF.
indicat Rapid flashing Node booting up
e ezl 1 second pulse Node active and idle

Table 2 - Indicator Behaviors
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3. System Operational Overview

The G-Link®-LXRS® contains an internal, rechargeable

AWARNING Lithium Polymer (Li-Po) battery. For important precautions

see Safety Information on page 64.

The G-Link®-LXRS® is susceptible to damage and/or

Ac AUTION disruption of normal operation from Electrostatic Discharge
(ESD). For important precautions see Safety Information on
page 64.

To acquire sensor data, nodes are used with any LORD MicroStrain® data gateway, such as the
WSDA® -Base -10x-LXRS® or WSDA®-1500 - LXRS®, and a software interface.

LORD MicroStrain® has two software programs available for the Wireless Sensor Network:
SensorCloud™ and Node Commander®. SensorCloud™ is an optional web-based data
collection, visualization, analysis, and remote management platform based on cloud computing
technology. Node Commander®is used for configuring gateways and nodes, selecting sampling
modes and parameters, initializing data acquisition, and viewing and saving data.

In this section system hardware and software setup is described, including an overview of the
Node Commander® software menus required to configure a sensor connected to the node and
begin data acquisition through the gateway. It is intended as a quick start guide and is not a
complete demonstration of all system or software features, capabilities, or settings. Refer to the
Node Commander® User Manual, the LORD MicroStrain® website, and the SensorCloud™
website for more information (see References on page 67).

%4 LORD MicroStrain
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3.1 Software Installation

To install Node Commander® Software Suite on the host computer, run the installer
executable file and follow the on-screen prompts for a complete installation. The software is
provided with all gateways and is available on the LORD MicroStrain® website ( see
References on page 67).

The Node Commander® software includes hardware drivers required for use
with USB gateways. Once installed, the software will automatically detect and
configure any USB gateways that are plugged into the host computer.

The suite includes the following programs:

« Node Commander is used for configuring nodes and acquiring, viewing, and
saving data.

« Live Connect™ is a TCP/IP-to-serial conversion tool that translates the
communications between Node Commander and an Ethernet gateway.

« WSDA® Data Downloader is used to download acquired data from the flash
memory card embedded in an applicable gateway to a host computer.

SensorCloud™ is an optional data collection, visualization, analysis, and remote
management tool. It is based on cloud computing technology and is accessed directly from a
web connection. Automatic, real-time data collection is available through Ethernet
gateways, such as the WSDA®-1500 - LXRS® and any already collected data can be easily
uploaded for visualization and analysis. Because it is web-based, SensorCloud™ requires
no installation. For more information see Data Handling on page 24.

Users can also design custom programs with the open source data communications
protocol (see References on page 67).

%4 LORD MicroStrain
B SENSING SYSTEMS



G-Link®-LXRS® Wireless Accelerometer Node User Manual System Operational Overview

3.2 System Connections

To acquire sensor data the following components are needed in addition to the node: a LORD
MicroStrain® data gateway and a local or networked host computer with access to the data
acquisition software (such as Node Commander® and SensorCloud™). For a connections
overview refer to Figure 3 - System Connections .

Nodes will communicate with any LORD MicroStrain® data gateway. The sensor, node,
gateway, and software selection is application-dependent, but the basic interfaces are the
same. Communication protocols between the gateway and host computer vary depending on
which model gateway is used, but they all require interface to a host computer or network. The
WSDA® -Base -10x -LXRS® gateway utilizes local serial connections to the host computer,
such as RS232 and USB, and interfaces with the Node Commander® software. The WSDA® -
1500 - LXRS® gateway utilizes Ethernet communications and can be used with Node
Commander® and SensorCloud™, although system configuration is completed using Node
Commander®. Gateways with analog outputs can be connected directly to stand-alone data
acquisition devices for data collection, however system configuration will still occur through a
USB interface to Node Commander®.

Users can also write custom programs by utilizing the LORD MicroStrain® Wireless Sensors
Network Software Development Kit (see References on page 67).

computer or network

communication

/
cable
Cc 0D

-

power cable, as needed //

(not used with USB gateways) > f . /;/ W gateway

Figure 3 - System Connections
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3.3 Gateway USB Communication

The WSDA-Base USB gateway is used as an example in this quick start guide. For information
on how to use other gateways, refer to the gateway or Node Commander® user manual (see
References on page 67).

Drivers for the USB gateways are included the Node Commander® software installation. With
the software is installed, the USB gateway will be detected automatically whenever the
gateway is plugged in.

1. Power is applied to the gateway through the USB connection. Verify the gateway
status indicator is illuminated, showing the gateway is connected and on.

2. Openthe Node Commander software.

Node
Commander

3. The gateway should appear in the Controller window automatically, with a
communication port assignment (Figure 4 - USB Gateway Communication). If it is not
automatically discovered, verify the port is active on the host computer, and then
remove and re-insert the USB connector.

* s> Base Station Com 3

Figure 4 - USB Gateway Communication

% LORD MicroStrain’
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3.4 Connectto Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

3.4.1 Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.

1. Toadd a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 5 - Adding a Node by Address).

2. The node address and frequency are indicated in the documentation included with
the node when it is purchased. Enter the node address, and select OK. If the node is
not found, a message will appear and provide the option to scan for the node on other
frequencies. Alternately, the Node Discovery feature can be used.

¥ Node Command

i Fle Edit View LaunchApplication Help
DL EONBKOE LD ZT ) 4e
i Controller BX

B Sion o ]

Monitor Mode
Reverify Base Station
Add Nodes | AddSingle Node
Configure »| Node Discovery
P Scan Network

Network Broadecast > ‘ ScEnifreienic

Remove Base Station

/ Add Node - Base Station 3
» 31463 |5

Node is assumed to be
on channel 15 (2.425 Ghz)

[k ] [ concel ]

Figure 5 - Adding a Node by Address

3.4.2 Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies. To connect to nodes using node discovery, begin
by making sure the node(s) are powered off.

%4 LORD MicroStrain
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15

not in normal boot up mode, the assigned one can be bypassed to enable node

|
|
|
|
Automatic node discovery may not work in some boot-up modes. If the nodeis |
|
|
|
discovery. For more information see Troubleshooting on page 43. |

|

|

. Right-click on the gateway name and select Add Node > Node Discovery (Figure 6 -
Using Node Discovery).

Turn on the node with the node power switch. Within a few seconds during power-up,
the node will transmit a message with its operating frequency.

When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, it has completed the normal boot- up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window, and scanning can be stopped by selecting the Stop button in the
Node Discovery window.

B Node Commander® 7. i m— T L o i o ¥ 1 .
i Fle Edit View LaunchApplication Help

L EESK L ANE-L X TN IEARSCN K - ES S A =)

o Base Station Com 3
#1- %) Node 372 (NEW)

Please cycle the power on all nodes you'd like Node Commander to find.
Discovered nodes will show up under Base Station Com 3.
Click the stop button to leave node discovery mode.

[”] Find sampling nodes on frequency 23

_—

Figure 6 - Using Node Discovery
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3.5 Channel Configuration

The sensor settings are stored in the node memory and each sensor is assigned a
corresponding channel number. Only the channels and configuration options that are
available on the type of node being used will appear in the configuration menus.

1. To enter the configuration menu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.

a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherentto the node being used.

b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.

c. Configure: Select the channel's Configure button to change the channel
parameters, such as measurement units, gain and offset settings, and
calibration values. The channel must be enabled first by selecting its
adjacent check box.

sopicaton tidp
6.0 Swi o Sl e %)
gt
Sample

“]

'
Configure N Cofigurabode | ”"

Fead/Wire EEPROM
Cakbration Coefficients ¥
Frequency

Channels | Streaming | Synchronized Samolion.
-
Channel - Physical Units Conversion

Enabled Data Output Units Gain Label Configure
# " — e
a 1.[¥] waew Acceleration (= o mm C
-2 ()
2.[¥] edw Acceleration G =
-
3. e Acceleration G o
i

4. i Temperature L

posty | [ ok ][ concel |

Figure 7 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 7 - Node Channels Menu. The channel configuration menu options change
depending on the sensor type selected.

a. Channel Label: names the channel
b. Channel diagram: shows channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement being made

d. Sensor Slope: is the sensor sensitivity value used to convert sensor
voltage reading to engineering units. For the G-Link -LXRS this value is
provided from the factory calibration.

e. Conversion Formula and Effective Range: is the formula used to
convert sensor readings to engineering units. It also shows the resulting
sensor measurement range.

~
Ir(hrngl_ Samples Wireless Samples Output i
Accel © (bits) Communication (bits) Upjts==
SR S el =
Conversion Coefficents Test
e (e G
C Urits: [s vJ A/D Value (bits):
Unable to convert from bits to Acceleration.
The coeffidents have been reset.
e Calibrated Value:
d e # Sope: 1 Offset: 0
Conversion Formula: output=slopebits+offset
—

e q EffectveRange: 0o 40956

Figure 8 - Channel Setup
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3.6 Sampling Settings

Sampling settings are accessed through the Configure Node menu. There is a tab for each
sampling mode available for the particular node (Figure 9 - Sample Settings Menu).The G-
Link®-LXRS® has four primary sampling modes: Synchronized Sampling, Low Duty Cycle
Sampling, Streaming, and Datalogging. Some modes have user-configurable settings for
sample rate, sample duration, and datalogging. Other settings are automatic, depending on
number of active channels and other variables. For more information on sampling modes
refer to the Node Commander user manual (see References on page 67).

|
|
|
l
Streaming mode (which enables continuous sampling and transmitting) uses a i
large amount of system bandwidth and can significantly reduce node battery i
life. Streaming is recommended primarily for diagnostics and is not supported in |
SensorCloud™. |

|

|

In general, when determining which sample mode and rate is most suitable for the
application, consider the following:

« Increasing the sample rate or duration reduces the available over- the- air
transmission bandwidth and therefore also reduces the number of nodes that can be
reporting simultaneously.

« Increasing the sample rate or duration increases the power requirement of the node
and therefore reduces the node's battery life.

« When measuring vibration or other analog signals, it is important to use a sample rate
at least twice the value of the target measurement frequency. This is the minimum
sample rate required to produce an accurate digital representation of the measured
signal. The higher the sample rate, the more accurate the digital representation.

%4 LORD MicroStrain
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/

[ channeis |streaming | Synchonized Samping [Low Duty Cyde | Dataloggng PPower [RE [info |
______

Sampling Settings ~ = " = = - — - ] show Advanced Options:

[FIBurst Sampiing

- —
[T Uniimited Sample Duration
Time Duration: 0.195313 [=-sec.

Percent of Total Bandwidth: 25.02 %

Event Driven Sampling: []Enable | Configure

o) Co ] o)

Figure 9 - Sample Settings Menu

3.7 Data Acquisition

|
|
|
l
Once sampling has started it will continue as configured without the need to i
leave Node Commander® open. However, if the node is powered off and is not i
configured to sample on boot-up, data acquisition will end and must be |
restarted in Node Commander®. i

|

|

When data acquisition is started, each of the sampling modes has different menu options and
views. Some open a settings menu before data acquisition begins and may include a data list
view and/or a graph view. The following is an example of Synchronized Sampling ( Figure 10 -
Starting a Sampling Session). For more information about synchronized sampling and using
the gateway beacon see Data Acquisition on page 19. For more information about other
sampling modes, refer to the Node Commander® user manual. (see References on page 67).

To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, they will all be set to the same sampling mode. Right-click on the nodes and select
Sample > Synchronized Sampling.

%4 LORD MicroStrain
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© Ble Edt Yiew LsunchApplicstion Help
50 o B O RS B e AE

5% Nodelld|  Semple +|  Synchionized Sampling
Communicate » | LowDuty Cycle

Stream
Configure »
e Datalogging

i Fle Edit View Lasunch Application Help

2 i 4 @ M e s
Mo 8 O BEE]LL ISP e 88
{ Controlier g .
&+ Base Station Com 3

Rl Node 30252
G Pl Node 31463 .
Sample b Synchronized Sampling
Communicate b| LowDutyCycle
Trigger Datalogging

Configure

Dewnload Triggers

Figure 10 - Starting a Sampling Session

When a synchronized sampling session is started, the sampling menu appears and includes
settings to enable optional sampling features, configure nodes, and to specify where the data
will be saved. The built-in bandwidth calculator displays the total bandwidth used by the nodes
selected for synchronized sampling (Figure 11 - Synchronized Sampling Menu).

a. Save Location: indicates where the data file will be saved on the host computer.
Use the Browse button to select a preferred location.

b. Node configuration: includes the node serial number, sampling settings,
bandwidth calculation, and current status. Highlight any node or group of nodes,
and the Remove, Configure, and Refresh buttons become active. The Configure
button opens the node configuration menus to adjust settings as needed and
recalculates the node bandwidth. Multiple nodes can be configured together by
using the Shift or Ctrl key to select them.

c. Lossless: enables the lossless data protocol. The protocol enables buffering and
retransmission of data in order to provide 100% data collection success. Using this
feature may increase data display latency.

%4 LORD MicroStrain
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= Uy
Nodes (2) Trpe Actve Channels  Sample Rate Sweeps %ofeandudih  Status =
Node 0252 GLnk 106 LURS) 1 51202 Lrimted 25.024 % In Netwerk
b N I S I O S Y S

- —

Figure 11 - Synchronized Sampling Menu

d. High Capacity: reduces the transmit rates in order to optimize bandwidth and
power savings among nodes with slower sample rates.

e. Network Bandwidth: is the total bandwidth used by all the nodes.

f. Enable Beacon on Start: When synchronized sampling is started the nodes wait
for the first beacon transmission to initiate sampling. When this option is selected
(default), the gateway beacon is enabled and will begin transmitting at a fixed
interval when sampling is started. Disabling the beacon on start (unchecking the
box) will set the nodes to wait for the beacon, but it does not actually start the
beacon when sampling is started. This can be used if there is a need for sampling to
be initiated later, or if the beacon is being received from another source than the
gateway. Enabling the beacon in this way is the same as enabling the beacon in the
gateway menu Refer to the Node Commander® User Manual for more information .

g. Apply settings and start sampling: Before acquisition can begin, use the Apply
Network Settings to save the session settings to the node. When completed, select
Start Sampling to begin.

h. Close sampling window (with the red "X") to exit sampling or, once the sampling
has been started, to view the data window behind it.

%4 LORD MicroStrain
21 SENSING SYSTEMS



G-Link®-LXRS® Wireless Accelerometer Node User Manual System Operational Overview

Synchronized sampling features two data views: Grid view and Graph view. Once sampling is
started, the data grid view is the default view (Figure 12 - Synchronized Sampling Data View).

|
|
|
|
When synchronized sampling is set to slower sample rates it may take several |
seconds after sampling is initiated for the first sample to appear. i

|

|

- = —_— e ———
2 Base Stabion Com 3 Qonstorng) ) | o wode: (Paam] Savrn To: © 02162014 T15_52.27 Mgy OBHE01 P7PS_50087 oy, d C Open | FleScsigave ™\

a 5% Node 30252 (Syrnc) 7 -~ -
- u Madek G-Link 106, v Mode: Info Channel 1 Chamel 2 Channel 3 Charnel 4 Chamnel S \ Base RSSI Mode RSST —— -
ermeTs i i) e v _ sea
SN 41943690 Sucle Rate S T
4, Firmwore: 805 TomiSargies 32614
& Memony Fulb 1% Temer Tick 313 (5
el Num Triggess: 14 Lo;l;m ]
=% MNode 31463 (Sync) o PERct Succezs 'bﬂaq..
B Modet V-Link lb = Node 31463 \ 32287 = E 1] 320 ~24dBm 26 dBm
Ul Options LXRS. Seeroie Rate bkl
;S 2433-31463 I TeRml Sy oy ]
A, Fitrowan €818 Toner Bk . b
Memery Full: 0% e 3
P oy b | A
e Num Triggers 0 N
-~ #
S — -

Figure 12 - Synchronized Sampling Data View

a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name.

b. Node information: includes node serial number and sampling statistics. Right-
click on the node name for more menu options such as Stop Nodes.

c. Data: is a display of the sampled data with each channel in a column.

d. Radio strength: indicates how good the communication is between the gateway
and node. See Range Test on page 32.

e. Data file: the location and size of the data file, as data is added. View the data in
.CSV format with the Open File button.

f. View menu: Select between Data Grid and Graph views.

g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.

%4 LORD MicroStrain
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Use the view menu to select the Graph view of the data (see Synchronized Sampling Graph
View on page 23). Click on the node name to view the graph for that node. Click again to hide it.

o | MG ]S
: Controlier 1%, A sampled Data [
& Base Station C
@8 Mode 30252 (Sync) S
% Node 31463 (Sync) sttt NGy YRoisZoom(%} 100« 3 Flaue
(@mmsz
Hode 31963y
#
—

Viewbiods: [Giaph 7| Savig Toe C 'x NodkC Datatse: 90014 T16_54_05\Masler_0219-2014 T16_54_05 csv (_- [_Open | Fiesze130MB
au

45000

a 35000

Figure 13 - Synchronized Sampling Graph View

a. Available Nodes: Click on the node to display the graph for that node. Click again
to hide it. Right-click on the node name for more menu options such as Stop Nodes
and Save Stream.

b. Axis range: Select the X-axis width and Y-axis zoom percentage, or use the Auto
check box for automatic scaling.

c. Graph: The node graph shows the sampled data. Each active channel is displayed
in a different color. The X-axis is time in seconds and the Y-axis is the A/D value
(bits). Right click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause, and Remove Graph.

d. View menu: Select between Data Grid and Graph views.

e. Data file: The location and size of the data file as data is added. View the data in
.CSV format with the Open File button.

f. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.
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3.8 Data Handling

Data acquired through Node Commander® is automatically saved on the host computer (see
Sensor Data Files on page 28) and can also be viewed from the web-based SensorCloud™
portal. Saved data can be uploaded to SensorCloud™ and Ethernet gateways provide the
option to automatically port the data to SensorCloud™ during data acquisition for near real-
time display and aggregation.

SensorCloud™ is based on cloud computing technology and is designed for long term
collecting and preservation of data. Features include time series and visualization graphing,
automated alerts, and data interpretation tools such as data filtering, statistical analysis, and
advanced algorithm development with the integrated MathEngine® interface. Leveraging the
open source API, SensorCloud™ can also be used to collect data from other LORD
MicroStrain® sensor products or third-party systems. Basic SensorCloud™ services are
available to all users free of charge (see Connect to SensorCloud™ on page 25).

« MicroStrain »

HodeCommander » Data » Ssmpled Data » session 03-30-2013 T15 4608

5] Master_09-30-2013 T19 46 08.csv
5] Node372.cov
) Sensodnfo_09-30-2013 T19_46_08.csv
) Synchetworkinfo 09302013 T19_46 08...

ch2 1Hz
ch3 1Hz
chd 1Hz

88 Computer

‘ | & rocuomeccy

) ‘3 NN I““ N Timestamp (GMT) ch1 ch2 ch3 cha
Y T G 0 | ““J H 1N s3:17.5]_1475.45] 1458.594 0.703699 2166.703
53:19.9 1473023 1488.775 0.703585 2166.704
53:20.9 1474546 1492239 0.704699 2166.704
53219 1475.745 1493.966 0.704446 2166.704
53:22.9 1476.143 1491654 0.705406 2166.705
53:23.5 1486.709 1452854 0.705143 2166.705
53:24.5 1486.581 1492.897 0.704363 2166.706
53:25.9 1477.195 1488.558 0.70439 2166.706
53265 148635 1453403 0.70435 2166.707
5327.9 147512 1488122 0.70352 2166.707
53:28.9 1473.597 1491.184 0.706812 2166.707

Frequency vs Log(Amplitude)

] — StatelTest
10 End of Test

Figure 14 - Data Storage, Display and Processing
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3.9 Connectto SensorCloud™

Ethernet gateways, such as the WSDA® -1500 - LXRS® can be enabled to upload data
automatically to SensorCloud once the node sampling has been activated. Refer to the
gateway user manual for more information.

To connect to SensorCloud go to the SensorCloud website log-in page, and enter the log-in
credentials. Register as a new user if needed.

http://sensorcloud.com/log-in/

SensorCloud Login

Email

I

Password

Don't have an account? Sign Up now!

Figure 15 - SensorCloud™ Log-in or Register

The SensorCloud interface has six main views. When logging in as a registered user, the
Device view is the default. Navigate to other views by clicking the view name at the top of the
page (Figure 16 - SensorCloud™ Menu Views). The Data and Settings views are only
available once a device is selected from the device list.

Main menus
€D SensorCloud™ DEVICES ACCOUNT CSVUPLOADER MATHENGINES

- — -

_____________
Device lists — select a device to
access Data and Settings menus

Shared Devices
LAST HEARD FROM

Demno Devices

DEvIcE LAST HEARD FROM

714715 1436

Figure 16 - SensorCloud™ Menu Views
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Device - The device list shows every gateway and APl device associated with the
SensorCloud account, including owned, shared, and demo devices. This view provides links to
each device’s SensorCloud subscription plan, configuration options, and a summary of last
communications and data transactions.

Account - The account view is for logistic management of the SensorCloud account, such as
changing the log-in password, user email, and billing information.

CSV Uploader - The data upload feature enables data from any source (such as non-Ethernet
LORD MicroStrain gateways, or third-party sensor) to be uploaded to the SensorCloud
platform. The data must be in the LORD MicroStrain CSV format.

Data - This view is only available after a device is selected. It displays data that is collected from
sensor nodes or uploaded from files. Data selections are listed by node channel or a user-
defined label, and can be enabled for display in the graph window. The interactive graph has
navigational features such as panning, zooming, and an overview graph for single-click access
to data points or ranges. There are also use and management features such as viewing the
meta-data and downloading, embedding, and tagging data graphs.

Figure 17 - SensorCloud™ Data View

Settings - The settings view provides options for adding meta-data, configuring the data
displays for each channel, creating alerts based on data thresholds, setting the data timezone,
and more.

MathEngine® - is used to analyze sensor data. Functions include the ability to filter out
frequencies, smooth out noisy data, perform math operations such as Fast Fourier Transforms
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(FFTs), and more (Figure 18 - MathEngine® View) . MathEngine® interfaces with the
SensorCloud graphing view for faster processing. Users can write their own algorithms for
custom applications. Refer to the MathEngine® website for more information.

http://sensorcloud.com/mathengine

For more information about SensorCloud features and navigation, refer to the SensorCloud
website or contact LORD MicroStrain Technical Support.

http://sensorcloud.com

Frequency vs Log(Amplitude)

FrequencylHz]

Figure 18 - MathEngine® View

FF_Vibration0ata | FFT_Vibratienbata_LowPass10otz

ROCDRLIE
-
3

Peak value of 0.94
at 4.75 Hz

400 500

Figure 19 - FFT Graph in SensorCloud™
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3.9.1 Sensor Data Files

Data acquired in Node Commander is stored in .CSV format and can be opened with
Microsoft Excel, Quattro Pro, Open Office, or other CSV editors/spreadsheet programs.
Data in this format is easily uploaded to SensorCloud™ using the CSV Uploader. The data
files can be found on the host computer in the default directory or the location specified at
the beginning of sampling (as applicable). The files are organized in separate folders by
mode and then further categorized by date, session, and/or node serial number.

The default directory is: C:\ProgramData\Microstrain\NodeCommander\SampledData
Synchronized sampling and low duty cycle files are found in the Sampled Data folder.

Datalogging files need to be downloaded from the node before they are available for
viewing. They can be accessed through datalogging menus as well as the File menu. They
are stored by default in the Downloaded Triggers folder.

Streaming data is stored in the Streaming folder.

i Node Commander®) N
{ Ele Edt View LaunchApplication Help

![ Explore Data Directory ] \ﬁlg /
| Upload Data to SensorCloud £3 ‘II

— T T W —— e —— 2

- . T
Exit “: @U-\ i+ Computer » LocalDisk (C) » ProgramData » MicroSirin » odeCommander » Deta » = | 64| Seorch Dot )

& 9 Node372 [ Rl b vew Tosh e

v Z4Open Includeinkbrany~  Sharewithw  Bum  Newfolder

=~ [ @

|, Downieaded Trggers
Ji Samypied Data
|\ Stresming

@@ﬂ" I« MicroStrain » ommander » Data » Sampled Data »

File Edit View Tools Help

session 09-30-2013 T19_46_08

Organize v %) Open = Print Burn New folder
Name - Date modified Type Size
B Desktop K54 Master_09-30-2013 T19_46_08.csv

& Downloads ) Node372.cov
Il % Recent Places W30 Sensorinfo_09-30-2013 T19_46_08.csv
) SyncNetworkinfo_09-30-2013 T19 46 08... 9

237 KB|

1KB
1K8

1% Computer

&L Local Disk (C)

Figure 20 - Exploring Data

%4 LORD MicroStrain
28 SENSING SYSTEMS



G-Link®-LXRS® Wireless Accelerometer Node User Manual Node Installation

4. Node Installation
4.1 Mounting Recommendations

The G-Link®-LXRS® s rated for indoor use only, unless housed in a ruggedized outdoor
enclosure. Enclosures for the G-Link®-LXRS® are available from LORD MicroStrain®. Some
also accommodate D cell batteries, extending the battery operating capacity and duration. For
more information see Node Accessories on page 55.

There are two mounting tabs on the node, with holes for fastening. For proper coupling of the
accelerometer to the substrate being measured, it is recommended that the node or external
sensor (if applicable) be mounted with fasteners on a rigid surface. This will reduce higher
frequency losses.

The node can be mounted in any orientation, but it is recommended that it is mounted in a way
that optimizes wireless communications. In the G-Link®-LXRS®, the accelerometers should be
positioned as required for the application (see Sensor Frame on page 30). For more
information see Optimizing the Radio Link on page 31.

48.7 mm ———=
[1.92 in]

43,
[1.70n]

@4.7 mm
[.19 in]

21.3 mm
[.84 in]

Li 58.2 mm 44
[2.29 in]

Figure 21 - Mounting the Node
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4.2 Sensor Frame

During installation, the internal accelerometers are oriented such that the axis are aligned
appropriately for the measurement application. The axis orientation is referred to as the sensor
frame and is indicated on the device information label (Figure 22 - Sensor Frame). Each axis

has a corresponding channel designation in the G-Link®-LXRS® software (see Channel
Configuration on page 16).

Ch. 1 (X) Ch. 2 (Y
& ﬂ . — sensor frame

Ch. 3(2)

Figure 22 - Sensor Frame
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4.3 Optimizing the Radio Link

In ideal conditions, the nodes and gateway can communicate up to two kilometers apart. In
order to accomplish this, the node and gateway must be installed in a manner that optimizes the
wireless transmission. The G-Link®-LXRS® operates at a 2.4GHz transmission frequency.
The internal antenna has an omni-directional radiation pattern. Using any other antenna with
the node will void FCC compliance.

The best method for ensuring optimal radio communication is to conduct an RF survey of the
installation site. This is easily accomplished in Node Commander® by using the range test
feature to quantify the radio signal strength (RSSI) in various scenarios. See Range Test on
page 32 for instructions on using Node Commander® for measuring RSSI. The following are
general guidelines for maximizing transmission range:

« Establish Line of Sight (LOS) between the node and gateway antenna as best
as possible. Try to avoid obstructions between the antennas, such as buildings,
terrain, vegetation, or other physical barriers. Increase the mounting height of the
node to allow a clearer LOS path to the gateway. Height above the ground is also
important because reflections off of the ground can interfere at the receiver.
Generally, the higher above the ground the better.

« Minimize Radio Frequency Interference (RFIl) such as other equipment
antennas, especially those operating in the same frequency range. This includes
other nodes. If other antennas are required nearby, mount them at different
heights to minimize interference. Additionally, the specific node frequency is
selectable within its operational range using the Node Commander® software. Set
the devices to different transmission frequencies.

« Minimize Electromagnetic Interference (EMI) such as that which is generated
by power transmission equipment, microwaves, power supplies, and other
electromagnetic sources.

« Metal Objects in close proximity to either antenna, particularly ferrous metals
such as steel and iron, can be problematic for wireless communications. The
larger the object, the greater the influence.
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4.3.1 Range Test

After establishing communication between node and gateway, use the range test feature in
Node Commander® to monitor the signal strength and to optimally position the nodes,
gateway, and antennas for installation. Maximum achievable range is determined by the
gateway and node power settings (found in the device Configure menu) and is highly
dependent on the physical environment surrounding the devices.

1. Right-click on the node header, and select Communicate > Range Test.

i fle Edit View Launch Application Help

5

:i.fl

Communicate

Configure

Stop Node

Load Node Information

Remove Node

G Num Triggers: 0

Power Management

Figure 23 - Range Test Menu

2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher
the value (closer to zero), the better, but reliable communication can be
achieved between -75 dBm and 0 dBm. The devices is still able to
communicate between -90 dBm and -75 dBm, but it could be intermittent or
result in data loss. Position the node and gateway antennas where the best
RSSI value is observed.

" Short Packet Range Test - Node 31463

Good Pings: 9070 Bad Pings: 0 Success Rate: 100.00 %

ﬁ" Base RSSE -12 dBm Min:-12dBm  Max: -10 dBm

— |

q Node RSSE: -12 dBm Min: -12 dBm  Max: -10 dBm

| L I — ]

Figure 24 - Range Test Statistics
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5. Powering the Node

Apply only the input voltage range specified for the node in the

AWARNING polarity indicated. Failure to do so could result in personal

injury and permanent damage to the node (see Safety
Information on page 64).

The node can be powered with either the internal battery or an external source. These sources
cannot be used simultaneously; there is switch on the node to select which source to use. When
the node is manufactured, the switch is set to operate using the internal battery.

External battery holders are also available for the G-Link®-LXRS® and can be used to extend
battery operating capacity and duration. For more information see Node Accessories on page 55.

5.1 Selecting the Power Source

There is user-accessible switch to select the power source.

1. Verify the node power switch is in the OFF position and no external power is applied.

2. Use a small flat-head screwdriver to push the recessed switch fully to the desired
position, as indicated in Figure 25 - Power Source Selection. The figure shows the
node configured for an internal power source.

power source
selector switch

BOTTOM VIEW

EXTERNAL

switch
position

INTERNAL/
BATTERY

Figure 25 - Power Source Selection
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5.2 Using the Internal Node Battery

The G-Link®-LXRS® contains an internal, rechargeable
Lithium Polymer (Li-Po) battery. For important precautions
see Safety Information on page 64.

When the internal node switch is set for internal power, the node is powered by a rechargeable,
220 mAH lithium polymer battery. This battery is not user-serviceable.

Node battery life is highly dependent on operational parameters such as sample mode and
rate. More active channels and higher sample rates equate to decreased battery life. The
following graph shows an example approximation of the battery life for a G-Link®-LXRS®over a
range of sample rates operating in Synchronized Sampling mode. For additional G-Link®-
LXRS® power specifications see Power Profile on page 62.

Battery life aproximation for G-Link® -LXRS® 220mAH internal battery

1800

Sync.h ronized Sampling, '.I'rans.mit Only —f—— 1600
T T T T T T T 1400

; / T 1200

/ : : - 1000

8OO

600

Average battery life {(hours)

400

200

1sample
512 Hz 256Hz 128 Hz 64 Hz 32 Hz 16 Hz BHz 4 Hz 2 Hz 1Hz per Sleep

minute
== 1 ch active 20 36 57 60 62 253 398 605 890 399 1,638 1,654
== 3 ch active 11 17 30 42 59 213 493 588 921 398 1,638 1,633

Sample Rate (Hz)
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5.3 Charging the Node Battery

Use only the power supply specified for the node to charge

. . the battery. Using a power supply above the rated voltage

VA NING could cause personal injury and permanent damage to the

node. For important safety considerations see Safety
Information on page 64.

|
|
|
|
Touching sensors or charging the node battery while acquiring data may induce |
noise on sensitive sensor signals and is not recommended. i

|

|

1. Turn the node power switch off, and plug the node power supply into the node and
then into a 120/240VAC, 50/60Hz AC power source. Use only the power supply
specified for the node. Use the supplied power plug adapters, as needed.

2. Monitor the status of the charge indicators. For indicator meaning see Device Status
Indlicators on page 48. Continue charging until the indicator turns green to indicate a
completed charge. Charging takes approximately 6-8 hours from a full depletion.

charge indicators

AC power /
source

M= & g -

C.) S — = f

| < ;,gﬁ. B' (LI}
g <&

power supply plug adapter =5 e O

outlet adapters

Figure 26 - Node Charging
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5.4 Connecting an External Power Supply

Apply only the input voltage range specified for the node in the

AE NING polarity indicated. Failure to do so could result in personal

Eoly et injury and permanent damage to the node (see Safety
Information on page 64).

When the internal node switch is set for external power, the node may be directly powered by
the power supply specified for charging the node (or another regulated AC to DC power supply
with the appropriate output parameters, see Operating Specifications on page 60). It can also
be powered by an external battery or other regulated DC supply. The supply must deliver a
stable voltage between 3.2 and 9.0 V dc and be capable of sourcing at least 100 mA. External
battery holders and ruggedized outdoor housings that accommodate D cell batteries are
available for the G-Link®-LXRS® (see Node Accessories on page 55).

External power is applied through the power supply jack, Observe connection polarities, or the
node may be damaged.

power jack
power 1
jack pin sighal
center Vjeck
barrel GND

Figure 27 - External Power Connections
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6. Sensor Settings and Operation

. The node configuration interface includes settings for measurement units and conversion values.
The G-Link®-LXRS® sensors are calibrated at the factory and require no user adjustment of the
conversion values. There are preset measurement units, as well as a user-defined field. Because
the wireless sensor system is digital, the analog voltage readings from the sensors are converted
into a digital equivalent value based on the volt-to-bit scale of the internal analog-to-digital voltage
converter (A/D converter). Sensor readings can be displayed and recorded in A/D value (bits)
directly or further converted to engineering units by applying conversion values and a conversion
formula. For more information see Conversion Values on page 39, and for instruction of adjusting
units see Measurement Units on page 38.

6.1 Node Channels Designations

Sensors are assigned to a specific channel number at the factory and cannot be changed. For
sensor orientation information see Sensor Frame on page 30.

Channel Description

1 accelerometer channel 1 (x-axis)
2 accelerometer channel 2 (y-axis)
3 accelerometer channel 3 (z-axis)
4 temperature channel

Table 1 - Channel Designations
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6.2 Measurement Units

Sensor measurement units are set in the channel Configuration menu.

1. To enter the Configuration menu, right-click on the Node heading, and select Configure >
Configure Node. The Channels tab displays channel options available for the current node.

Samping | Low Duty Cyde | Datalogging [ Power [RF [ info |

G omown v e = o=
* LY wmae  Acceleraten G =) *. L
2@ wdw Aceeraton G (=
& ._‘: Acceleration G (=)
< i

4.F g Temperature

(o] o] [Cena ]

Figure 28 - Channel Configuration Menu

2. Select the type of measurement from the Class menu, and then select Units.

e )

i Channel Labei: |

\ Y

Internal Samples ‘Wireless Samples Output
Accel (bits) C (bits) Units.
Conversion Coeffigents Test

Class: [Acceleration .<
»mh: s - AD Value (its):

s Calbrated Value:

Sope: AT o 2552085

Conversion Formula: output=sliopebits +offset
EffectveRange:  2.55210-2.101G

Low Pass Fiter Cutoff (-3d8 pt.)

o) [oma ]

Figure 29 - Select Sensor Units
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6.3 Conversion Values

The conversion values for the G- Link®-LXRS® are determined when the device is
calibrated at the factory, and they require no user adjustment.

Three types of calibrations are available depending on the level of accuracy required for the
application: a standard calibration, a NIST-traceable, or ASTM-traceable calibration. For
more information see Parts and Configurations on page 54. For applications with unique
installation conditions it may be desirable to adjust the conversion offset value or perform a
field calibration. To determine if this is appropriate, contact LORD MicroStrain® Technical
Support (see Technical Support on page 52).

The conversion values include the slope, offset, and formula for converting the sensor A/D
value (bits) to engineering units. The bits are the digital representation of the sensor voltage
output. The type of sensor, channel, and desired engineering units determine what
conversion values are available. The conversion values are entered via the Node
Commander® and saved in the node memory for the applicable channel.

The conversion values can be entered in two menus (Figure 30 - Abbreviated Conversion
Values Menu and Figure 31 - Advanced Conversion Values Menu). The channel
Configuration menu has more options than the Calibration Coefficients menu, but both are
acceptable ways to enter the values and formulas.

[ Calibration Coefficients

Unit Offset
1 [standard »] y=mx#  [6 v] 000071 255235
2 [Standard x| vemxsb (6 +] o007z 2567206
3 |standard v | y=mx+b @ -0.000072 2.600181
4 [standard -| y=mx+b -0.06228 153.658005

(aeoy ][ o J[ conel ]

Figure 30 - Abbreviated Conversion Values Menu

%4 LORD MicroStrain
39 SENSING SYSTEMS



G-Link®-LXRS® Wireless Accelerometer Node User Manual Sensor Settings and Operation

Configuration (Channel 1} — Do (>
ChanrsiLabet:
oy [}
- e Commander
= ; " ase |
Internal Samples Wireless Samples Output
Accel (bits) (bits} Units

B . = Converson Coeficents Test
Configuration - Node 34905 peere i L R
Class: [Accelerabin Semple Channel

| Channels [ Streaming | Synchwonized Samping | Low Duty Cyde | Datalogging | Poner [RE__ [ 1nfo_| unts: [ Bl AP Value (bs):

Channel Physical Uits Conversion Hardware Ll
Enabled Data Output Units Gain - m  Colbrated Vabe:

-~ as10G
L@ wdw Aceemation S {QF# Slope: 0.000071 Offcet: 2552365 [fr=n)}

2.[7) wdw Aceleration G = ~
bl Conversion Formua: cutputesiope bits soffset
3. e Acceleration € (=] EffectiveRange:  2.55210-2.101G

«F i ——— < Low Passs Fiter Cutoff (-3d8 pt.)
d X m—) o ] [Coma |

Configure
|

e e

Figure 31 - Advanced Conversion Values Menu

Conversion Formula: The conversion formula assumes a linear relationship between the
original units (such as A/D bits) and new engineering units (such as g-force), and it is
expressed mathematically as y=mx+b, where y is the engineering units at a given point
(measurement), mis the slope of the line that represents the linear ratio, x is the original unit
value at a given point, and bis a unit conversion offset (in the case of unit conversions) or the
fixed zero load offset of the sensor (in the case of measurement calibration coefficients).
Negative values may be entered for any coefficient.

Slope: is the linear scaling slope coefficient. The slope is the ratio of original units to new
engineering units (EU), and it is used to convert the sensor measurements. The slope
conversion value will vary depending on the engineering units desired. For example if the
original unit is A/D values (bits), and the desired engineering units are acceleration in g-
force, the slope conversion would describe how many bits equal one unit of g-force (bits/g).
Mathematically, the slope is min the formula y = mx +b.

Offset: is the linear scaling offset coefficient, and it is typically the starting output value of the
sensor with no load applied (in the original units). Mathematically, the offsetis bin y = mx +b.

Effective Range: the effective range is the calculated sensor measurement range in
engineering units (EU). The effective range is dependent on the slope, offset and resolution
of the node. The effective range is the number of bits per EU unit (slope) multiplied by the
total number of bits, minus the offset (if applicable).
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6.4 Operational Considerations

6.4.1 Measurement Range

The accelerometer bandwidth limits the range of frequencies that can be measured. As the
measured vibration frequency approaches the upper bandwidth limitation of the
accelerometer, the accelerometer sensitivity decreases. The result is a predictable
reduction in the measured vibration amplitude when measuring beyond the bandwidth limit.
The bandwidth limitation is indicated in the node specifications (see Specifications on page
58).

The low pass filter cutoff frequency setting (see Channel Configuration on page 16) limits
the measured readings that will be reported based on the frequency of the signal.
Frequency readings above the selected setting will decrease in amplitude, just as with the
accelerometer bandwidth limit. For best performance select a cutoff frequency that is no
more than half of the sample rate. For example, if the target measurement is 100 Hz, and
the sample rate is set to 500 Hz, set the cutoff frequency between 100 Hz and 250 Hz.

6.4.2 Node Sampling Rates

The G-Link®-LXRS® is capable of sampling up to 4096 Hz . For measuring vibration it is
recommended to use a sample rate at least twice the value of the target frequency. This is
the minimum sample rate required to produce an accurate digital representation of the
measured signal. For example, if the target measurement is 100 Hz, the sample rate should
be setto 200 Hz or higher.

While the G- Link®-LXRS® is capable of high sample rates and high resolution conversions,
the integrated accelerometer may limit performance in certain circumstances. For example,
even though the G-Link®-LXRS® can sample up to 4096 Hz , the integrated accelerometer
(in the standard configuration) only has a bandwidth of500 Hz. Setting the node to sample at
4096 Hz would result in oversampling by a factor of about 8, which is well over typical
practices. Oversampling by a factor of 4 times is enough for most applications.

6.4.3 Gravity Offset

During data acquisition it is normal to see up to -1g offset due to the effects of gravity on the
sensor axis (Figure 32 - Gravity Offset). For more information on the sensor reference frame
see Sensor Frame on page 30.
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Figure 32 - Gravity Offset

6.5 On-board Temperature Sensor
« The G-Link®-LXRS® has an on-board, solid state temperature sensor mounted on
the surface of the circuit board.

« The temperature sensor output is connected to channel 4 of the G-Link®-LXRS®

- Refer to the node specification table for the temperature sensor operating
parameters (see Operating Specifications on page 60).
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7. Troubleshooting

7.1 Troubleshooting Guide

1. POWER 2. COMMUNICATION 3. DATA ACQUISITION
gateway or node does no communication to sensor data is missing
not turn on, or node the gateway or node or incorrect
does not charge
1.1 2.1 3.1
| node or | node or | nocomto
gateway power gateway has node or
\ is off ) . nopower \ gateway )
1.2 22 3.2
external power || gateway has || sampling
off or miswired no com with settings are
\ ) . computer incorrect
1.3 23 ShE
wrong power || node cannot | sampling has
supply or be configured not started
\ voltage ) \ ) \ )
1.4 2.4 3.4
node internal || nodeis out of || sensor channel
source select range not configured
. incorrect \ / . correctly
1.5 25 3.5
|| node battery is || nodeis not in il ] sensor
dead normal boot calibration is
\ / \ mode ) \ invalid )
1.6 2.6
|| node battery [ | node is
fault sampling
7 _
1.7 2.7
node or = node is
gateway is sleeping
. damaged
2.8
gateway or
node is
damaged
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Problem Possible cause and recommended solution

1.1 node or gateway power is off

1. POWER The status indicator LED on the device may be off. Turn the

gateway or node does device on, and the status indicator LED should illuminate.

not turn on, or node 1.2 external power is off or miswired
does not charge

Verify the device power source is connected correctly and
powered on.

1.3 wrong power supply

Using a power supply other than the one specified for the device
(or an external supply that is outside of the device operating
range) could result in permanent damage to the device or cause
it to not work properly.

1.4 node internal source select switch is incorrect

When the node is manufactured, it is set to internal battery
operation, but it can be configured to accept an external source.
When set to accommodate an external source, the battery
cannot be charged.

1.5 node battery is dead

If the node power source selector is set to internal, and the node
will not power on or charge, the node battery may need to be
replaced. Contact LORD MicroStrain® Technical Support (See
Technical Support on page 52).

1.6 node battery fault

If the battery charge indicator on the node is only dimly
iluminated when charging is attempted, a battery fault condition
has occurred. Unplug power, and then plug it back in. The
indicator should turn on brightly, indicating charging.

1.7 node or gateway is damaged

If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®
Technical Support (See Technical Support on page 52).

2.1 node or gateway has no power

2. COMMUNICATION

%4 LORD MicroStrain
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Problem Possible cause and recommended solution

no communication to Verify the node and gateway have power applied and that
the gateway or node applicable power switches are on. Power is indicated on both
devices by a status indicator LED.

2.2 gateway has no communication with the computer

Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as applicable.

« For serial gateways, verify that the COM port setting.

» For USB gateways, verify that the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.

« For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®
Edit > Preferences menu, under Devices. Once
communication has been established, the network
configuration can be changed.

2.3 node cannot be configured

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling or sleeping, it cannot be configured. In Node
Commander®, execute the Stop Node command to put the
node in idle state, allowing configuration to occur.

If the user inactivity timeout is set very low, the configuration
menu will have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.

2.4 node is out of range

Perform a bench test with the node in close proximity to the
gateway to verify they are operational. For range test and
installation recommendations see Range Test on page 32. The
system has been tested to operate with the node and gateway
up to 2 km apart with clear line of sight.

2.5 node is not in normal boot mode

%4 LORD MicroStrain
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Problem Possible cause and recommended solution

If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by toggling
the node ON/OFF switch rapidly three times, then leaving it in
the ON position for normal power up. In normal boot mode the
communication can be established with automatic node
discovery (or manually) once the boot process is complete and
the node is in idle state. Start-up mode can then be changed in
the software.

2.6 node is sampling

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling, it cannot be configured. In Node Commander®,
execute the Stop Node command to put the node in idle state,
allowing configuration to occur.

2.7 node is sleeping

Observe the node status indicator LED to determine what state
it is: boot, idle, sample, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander®, execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.

2.8 gateway or node is damaged

Verify all connections, power, and settings. If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified. If no conclusion can be
determined or to send a device in for repair, contact LORD
MicroStrain® Technical Support (See Technical Support on
page 52).

3.1 no communication to node or gateway

3. DATA ACQUISITION Verify connections and power to the node and gateway. Verify
they are powered on and communicating with the software.
Enter a configuration menu to verify that the node can be
accessed.

sensor data is missing
or incorrect

3.2 sampling settings are incorrect

If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
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Problem Possible cause and recommended solution

sampling settings.

3.3 sampling has not started

If sampling is occurring, the sampling mode will be displayed
next to the node name in Node Commander®. The node device
status indicator will also be flashing the sampling mode code. If
the node is not sampling, activate it in the software or with a
sample on start up boot sequence.
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7.2 Device Status Indicators

The following is a complete list of the G-Link®-LXRS® status indicators.

Indicator Symbol Behavior | Node Status
Battery charge OFF No power source detected
source indicator ON green Charging source detected
Battery charged OFF Node not charging
indicator ON bright red Node battery charging

OFF Node charge status unknown
Completed “ gN green Battery;ully charggd
charge indicator N green an(_i Battery au!t condition. Reset
battery charging by unplugging power and then
indicator ON red plugging it back in
OFF Node OFF or sleeping
OFF, with Node sleeping with radio c_:heck
. intervals enabled (default is
occasional flash
every 5 seconds)
Tenrapid flaghes Node booting normally and
when power is .
- : sending out a status message
initially applied
1 second pulse Node active and idle
Device status Continuously ON Node datalogging or streaming
s data
indicator . ——
Node is sampling in low duty
1 Hz pulse green . .
cycle or synchronized sampling
Node is sending out
Pulses for each communication requests (such
ping as in ping command, range
test, or EEPROM read/write)
Four to seven slow
pulses when power Fault condition
is initially applied

Table 3 - Device Status Indicators
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7.3 Updating Node Firmware

Under the recommendation of LORD MicroStrain® Technical Support Engineers, nodes can
be upgraded to the latest available firmware to take advantage of new features or correct
operating issues. Node Commander® version 2.7.0 or greater can be used to update any
mXRS® or LXRS® node or gateway firmware to the most current version. Updates are found
on the LORD MicroStrain® website. See Technical Support on page 52 for contact and
website information.

1. Download the LXRS® Firmware Upgrade file from the LORD MicroStrain® website.

2. Once downloaded, extract the contents of the .zip file into a folder on the computer.
Verify there is a file with a .zhex extension.

3. Launch Node Commander® , and establish communication between the node and
gateway as normal.

4. While holding F1 button on the keyboard, right-click the node name, and a drop-down
menu will appear.

!
Sal

i File Edit View LaunchApplication Help
Mo @O Rl LD

Controller Sk
#z* Base Station Com 36

& !,: Nod= 412 i
Upgrade Firmware j

Figure 33 - Update Node Firmware
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5. Releasethe F1 key.
6. Click Upgrade Firmware, and the Node Firmware Upgrade window will appear.
7. Click Browse, and navigate to the downloaded .zhex file.

8. Click Write, and the upgrade sequence will begin. When completed, "Upgrade
Success" will appear in the Status column.

Node Firmware Upgrade
Nodes Tyve Bootloader Verson  FW/ Befoce Upgrade  FW After Upgrade  Status
Node 418 Gk 26 1.08 800 8.5 Fmware found. Ready.
/
Path: C:\Users'b_trutor|Desktop microstrain_yireless_frrmware_V2_1_0.zhex [ mowse | [ e

Figure 34 - Upgrade Firmware Window
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7.4 Repair and Calibration

The G-Link®-LXRS® s factory calibrated when it is manufactured. No further calibration is
required.

E]H General Instructions

In order to return any LORD MicroStrain® product, you must contact LORD
MicroStrain® Sales or Technical Support to obtain a Return Merchandise
Authorization number (RMA). All returned merchandise must be in the original
packaging including manuals, accessories, cables, etc. with the RMA number
clearly printed on the outside of the package. Removable batteries should be
removed and packaged in separate protective wrapping. Please provide the
LORD MicroStrain® model number and serial number as well as your name,
organization, shipping address, telephone number, and email. Normal turn-
around for RMA items is seven days from receipt of item by LORD
MicroStrain®.

Warranty Repairs

%)

LORD MicroStrain® warrants its products to be free from defective material
and workmanship for a period ofone (1) year from the original date of
purchase. LORD MicroStrain® will repair or replace, at its discretion, a
defective product if returned to LORD MicroStrain® within the warranty period.
This warranty does not extend to any LORD MicroStrain® products which have
been subject to misuse, alteration, neglect, accident, incorrect wiring, mis-
programming, or use in violation of operating instructions furnished by us. It
also does not extend to any units altered or repaired for warranty defect by
anyone other than LORD MicroStrain®.

Non-Warranty Repairs

All non-warranty repairs/replacements include a minimum charge. If the
repair/replacement charge exceeds the minimum, LORD MicroStrain® will
contact the customer for approval to proceed beyond the minimum with the
repair/replacement.
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7.5 Technical Support

There are many resources for product support found on the LORD MicroStrain® website,
including technical notes, FAQs, and product manuals.

http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support
sensing_support@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

SKYPE: microstrain.wireless.support

Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern Time US & Canada)
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8. Maintenance

There are no user-serviceable parts on the G-Link®-LXRS®. For device service and repair contact
LORD MicroStrain® Technical Support (see Technical Support on page 52). Opening the device
will void the product warranty.
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9. Parts and Configurations
9.1 Standard Nodes

For the most current product information, custom, and OEM options not listed below, refer to
the LORD MicroStrain® website or contact the LORD MicroStrain® Sales Department.

LORD

Model Number Description MicroStrain®
Part Number

« Internal £2 gtri-axial
G-LINK-LXRS-2G accelerometer 6305-2000

« Internal temperature sensor

« Internal £10 gtri-axial
G-LINK-LXRS-10G accelerometer 6305-3000

« Internal temperature sensor

Calibration Options (required for use - specify at time of order)

The G-Link -LXRS is available in three versions based on the user-selected calibration option. The
products look and perform a little differently, and should be selected based on the application. The
three calibration options are Standard, NIST, and ASTM.

Refer to the operating and mechanical specifications for details (see Specifications on page 58),
and the applicable Technical Note (see References on page 67).

« Standard calibrations normalize each sensor channel to the rotation of the Earth's
gravitational field. This is the least accurate calibration.

« NIST traceable calibrations normalize each sensor channel to a reference accelerometer
that is traceable to the National Institute of Standards and Testing (NIST) criteria.

« ASTM traceable calibrations normalize each sensor channel to a reference accelerometer
that is traceable to the American Society for Testing and Materials (ASTM) F2137 criteria.
This criteria was developed by ASTM specifically for measuring the dynamic
characteristics of amusement park rides. This is the most accurate calibration option.
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9.2 Node Accessories

The following parts are available for use with the G-Link®-LXRS®. For the most current product
information, custom, and OEM options not listed below, refer to the LORD MicroStrain®
website or contact the LORD MicroStrain® Sales Department. See Product Ordering on page

57.
S Tt LORD MicroStrain®
P Part Number
. 1 X ® . . .
Charging power supply for G-Link®-LXRS® with international 6302-1000
plug adapters
IP66/NEMAA4 rated rugged outdoor enclosure
for G-Link®-LXRS® 6306-0100
IP66/NEMAA4 rated rugged outdoor enclosure
for G-Link®-LXRS® with two D cell battery capacity SRALE
IP66/NEMAA4 rated rugged outdoor enclosure
for G-Link®-LXRS® with three D cell battery capacity SRt
D cell battery tray for use with wireless nodes (indoor use) 6302-0200
AA cell battery tray for use with wireless nodes (indoor use) 6302-0300
Lithium D cell battery 19 Ah capacity 6302-0000
Lithium AA cell battery 2 Ah capacity 6302-0100

Table 4 - Node Accessories
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9.3 Wireless System Equipment

Parts and Configurations

The following system parts are available for use with the G-Link®-LXRS®. For the most current
standard, custom, and OEM product options, refer to the LORD MicroStrain® website or
contact the LORD MicroStrain® Sales Department. See Product Ordering on page 57.

Description

LORD
MicroStrain®

Part Number

WSDA-1500-SK Ethernet Data Gateway Starter Kit 6314-1501
- Node Commander® Software 6301-0300
SensorCloud™ Software Subscription
- (contact LORD MicroStrain® Sales) B

WSDA-BASE-104-SK USB Gateway Starter Kit 6307-1041

WSDA-BASE-102-SK RS232 Gateway Starter Kit. 6307-1021

WSDA-BASE-101-SK Analog Gateway Starter Kit 6307-1011

-- Replacement USB cable 9022-0029

-- USB Gateway cable extender 6307-0900

= Replacement serial cable 4005-0005

WSDA-1500 Ethernet Data Gateway 6314-1500

Ethernet Data Gatewa

WSDA -RGD (ruggedized to MILS-STD-461F/M IyL-STD 810F) ALY

WSDA-BASE-104 USB Gateway 6307-1040

WSDA-BASE-102 RS232 Serial Output Gateway 6307-1020

WSDA-BASE-101 Analog Output Gateway 6307-1010
G-Link2-LXRS Wireless Accelerometer Node various models
SG-Link-LXRS Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-OEM Wireless 2-Channel Analog Input Sensor Node various models
V-Link-LXRS Wireless 7-Channel Analog Input Sensor Node various models

IEPE-Link -LXRS

Wireless IEPE Accelerometer Node

various models

56

Table 5 - Wireless System Equipment
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9.4 Product Ordering

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature.

http://www.microstrain.com/wireless

For further assistance, our sales team is available to help with product selection, ordering

options, and questions.
Sales Support

sensing_sales@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern Time US & Canada)
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10. Specifications
10.1 Physical Specifications

Standard and NIST option
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[1.92 in]
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ASTM option
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Specifications

10.2 Operating Specifications

60

Integrated sensors

Parameter Specifications

Triaxial MEMS accelerometer, 3 channels
Internal temperature, 1 channel

Data storage capacity

2 M bytes (up to 1,000,000 data points, data type dependent)

Accelerometer Channels

Measurement range +2 gor+10 gstandard
Accelerometer bandwidth 0to 500 Hz

Accuracy 10mg

Resolution 12 bit

Anti-aliasing filter bandwidth

Standard and NIST option: Single-pole Butterworth, -3 dB cutoff
at 500 Hz (factory adjustable)

ASTM option: Six-pole Chebyshev filter at a user-specified
cutoff frequency (typically 37 Hz)

Integrated Temperature Channel

Measurement Range -40°Cto70°C
Accuracy and resolution +2°C (at 25 °C) typical , 12 bit
Sampling

Sampling modes

Synchronized, low duty cycle, datalogging

Sampling rates

Continuous sampling: 1 sample/hourto 512 Hz
Periodic burst sampling: 32 Hz to 4096 Hz
Datalogging: 32 Hz to 4096 Hz

Sample rate stability

+3 ppm

Network capacity

Up to 2000 nodes per RF channel (and per gateway) depending
on the number of active channels and sampling settings.

Refer to the system bandwidth calculator:
http://www.microstrain.com/configure-your-system

Synchronization between nodes

+32 usec

Operating Parameters

Radio frequency (RF)
transceiver carrier

2.405 t0 2.470 GHz direct sequence spread spectrum over 14
channels, license free worldwide, radiated power programmable
from 0 dBm (1 mW) to 16 dBm (39 mW); low power option
available for use outside the U.S.A.- limited to 10 dBm (10 mW)

RF range

70 m to 2 km line of sight with RF power setting

RF communication protocol

IEEE 802.15.4

Power source

Internal: 3.7 V dc,220 mAh, rechargeable lithium polymer
battery, External: 3.2V dc to9Vdc

Power consumption

See power profile :
http://files.microstrain.com/G-Link-LXRS-Power-Profile. pdf

Operating temperature

-20 "C to + 60 °C (extended temperature range available with
custom battery/enclosure, -40 °C to + 85 “C electronics only)

Acceleration limit

500 g (high g option available)

Physical Specifications

Standard and NIST option: 58 mm x 43 mm x 21 mm

Dimensions ASTM option:X mm x Y mm x Z mm
Weight 40 grams
Environmental rating Indoor use (IP65/66 enclosures available)
Enclosure material ABS plastic

Integration

Compatible gateways

All WSDA® base stations and gateways

Software

SensorCloud™, Node Commander®, WSDA® Data
Downloader, Live Connect™, Windows XP/Vista/7 compatible

Software development kit (SDK)

Data communications protocol available with EEPROM maps
and sample code (OS and computing platform independent)
http://www.microstrain.com/wireless/sdk
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Parameter
Regulatory compliance

Specifications
FCC (U.S.), IC (Canada), CE, ROHS

Calibration options

Standard, NIST, ASTM*

*ASTM option has different physical form factor and frequency filtering.
Refer to applicable Technical Note

61
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10.3 Power Profile

Node power use is highly dependent on the operational parameters such as sample mode and
rate. More active channels and higher sample rates equate to increased power use. Below is
an example approximation of the power use of a G-Link®-LXRS® over a range of sample rates
operating in Synchronized Sampling mode. This chart can be used to approximate external
node power source requirements. For G- Link®-LXRS® internal battery life specifications see
Using the Internal Node Battery on page 34.

G-Link® -LXRS® Example Current Use Profile

25
Synchronized Sampling, Transmit Only
20
‘E" 5
E
=
Q
-
E
=
o
% 10
i
H
<
5
0l = r_—-——-.———-._,___
1szample
sleep per 1Hz 2Hz 4 Hz BHz 16Hz 32Hz 64 Hz 128 Hz 256Hz 512 Hz
minute
=f=1ch active 0.133 0.134 0551 0.247 0.363 0.553 0.869 3537 3660 3.853 6158 11188
== 3 ch active 0.135 0.134 0553 0.239 0374 0.447 1.035 3720 5274 7435 12719 20255
Sample Rate (Hz)
Figure 35 - Example G-Link®-LXRS® Power Profile
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10.4 Radio Specifications

The G-Link®-LXRS® Wireless Accelerometer Node employs a 2.4GHz |IEEE 802.15.4
compliant radio transceiver for wireless communication. The radio is a direct-sequence spread
spectrum radio and can be configured to operate on 14 separate frequencies ranging from
2.405 GHz to 2.470 GHz. Following the 802.15.4 standard, these frequencies are aliased as
channels 11 through 24. For all newly manufactured nodes, the default setting is 2.425 GHz
(channel 15).

For standard models, radiated transmit power is programmable from 0 dBm (1 mW) to 16 dBm
(89 mW). A low-transmit power option is available (for use in Europe and elsewhere) and is
limited to 10 dBm (10 mW).

The radio complies with FCC Part 15 (USA) and IC (Canada) regulations. The radio is license-
free worldwide. Using antennas and transmission equipment other than what is provided may
void FCC compliance.

|
|
|
. The gateway can automatically manage nodes operating on different |
frequencies by using the Node Discovery feature in Node Commander®. In i
this routine, the gateway listens for node broadcasts on the frequency i
channel to which it is set. If the node is in normal boot-up mode, it will provide |
the broadcast when it is initially powered-on, and it will broadcast on all i
channels. As long as the node is powered-on after activating the Node i
Discovery feature, the gateway will link to it and remember the channel |
setting for future node queries. i
i

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

« Manually matching the node and gateway frequency channels is required in
some applications. For example, when sending broadcast messages from
the gateway to multiple nodes (including the synchronized sampling beacon)
all nodes must be on the same channel as the gateway in order to receive the
broadcast. Assigning channels is also a good idea when multiple gateways
are attached to one host computer or when other wireless equipment is
nearby and frequency or transmission interference may occur.
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11. Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain® Wireless
Sensor Network. Throughout the manual, ANSI Z535 standard safety symbols are used to
indicate a process or component that requires cautionary measures.

11.1 Battery Hazards

/A\WARNING A\CAUTION B¥,"[e)j[e]5

The G-Link®-LXRS® contains an internal, rechargeable

M ® Lithium Polymer battery. Lithium Polymer batteries are a fire
A and explosion hazard. Do not store or operate the node at
E temperatures above 212°F (100°C). Do not disassemble,
short circuit, crush, puncture, or otherwise misuse the battery.

When recharging the node internal battery, use only the
power supply specified for node charging, and follow the
M ' ) instructions. See Charging the Node Battery on page 35.
F A Applying a voltage above the input range may result in
dangerous battery conditions and cause permanent damage
to the node.

Lithium Polymer batteries contain toxic chemicals that are
harmful to humans and the environment. Disposal is subject
—== to federal and local laws. Do not discard the battery or the
é node in the trash. Follow proper battery disposal protocol, or
contact LORD MicroStrain ® Technical Support for
information on extracting the battery or returning the product
for proper recycling and disposal.
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11.2 User Configurable Power Settings

The G-Link®-LXRS® Wireless Accelerometer Node can be powered by either the internal
battery or an external source. There is user-accessible switch to select the source. The default
setting for this switch is for internal battery operation and charging. See Selecting the Power
Source on page 33.

A\CAUTION ¥,'[e)j[e/5
M @ Connecting an external power source when the node is set to
A

internal power could result in injury or permanent node
damage. For details on how to adjust the switch setting see
Connecting an External Power Supply on page 36.

« Ifthe node is set to use an external source, and the charging power supply is plugged
in, it will power the node from the power supply and not charge the battery. It will
continue to use the internal battery.

« Ifthe node is set to internal, and an external power supply other than the one used for
charging is plugged in, several things could happen. If it is a power supply that is in
the operating range of the charging circuit, it may charge the battery. Ifitis below the
range of the charging circuit, nothing will happen. If the applied voltage is above the
range of the charging circuit, damage to the node will likely occur and personal injury
may result.

« When under battery operation there is a limit to how much current the node can
provide to sensors. If the node is in an over-current condition it will shut off until the
cause is removed. Using an external power source for the node or sensor can
mitigate this issue.
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11.3 Power Supply

The G-Link®-LXRS® Wireless Accelerometer Node can be powered by an external source.

AWARNING A\CAUTION [, "[e) /el
Apply only the input voltage range specified for the G-Link®-
a LXRS®. Connect in the correct polarityto a power source

that is near the device, is accessible, and adheres to all
national wiring standards. Compliance with wiring standards
is assumed in the installation of the power source and
includes protection against excessive currents, short
circuits, and ground faults. Failure to do so could result in
personal injury and permanent damage to the device. For
details on how to connect the power supply see Connecting
an External Power Supply on page 36.

11.4 ESD Sensitivity

The G-Link®-LXRS® is susceptible to damage and/or disruption of normal operation from
Electrostatic Discharge (ESD), particularly during data acquisition.

A\CAUTION [ \[o)j[o]5

ESD damage can occur when the device is touched, especially at

o the device interfaces such as the antenna and connectors. Use

k ) proper grounding techniques when handling. If an ESD event

t occurs, and operation has been interrupted, reset the device by

cycling power to it and/or restarting the operational mode in the
system software.
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12. References

12.1 Reference Information

Many references are available on the LORD MicroStrain® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or

file copies.
Document Where to find it
SensorCloud™ http://www.sensorcloud.com/system-
Overview overview
MathEngine® Overview http://www.sensorcloud.com/mathengine

LORD MicroStrain® Wireless Sensors

Network Software Development Kit http://www.microstrain.com/wireless/sdk

Product Datasheets http://www.microstrain.com/wireless/sensors
Product Manuals and Technical Notes http://www.microstrain.com/support/docs
Product Application Notes http://www.microstrain.com/applications
NIST Calibration Procedures http://www.nist.gov/calibrations/
ASTM Testing Procedures http://www.astm.org/S_tandard/standards—
and-publications.html

Table 6 - Related Documents
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12.2 Glossary
These terms are in common use throughout the manual:

A/D Value: the digital representation of the analog voltages in an analog-to- digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics; higher resolution produces a more accurate conversion. Also referred to as "bits".

ASTM: The Association of Standards and Testing is a nationally-accepted organization for the
testing and calibration of technological devices.

Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). Itis also referredto as a
“gateway”.

Bits: the digital equivalent of voltage on the node. See '‘A/D Value'.

Burst Sampling: a mode of operation in synchronized sampling that takes momentary high
sample rate readings with configurable time durations and intervals

Calibration: to standardize a measurement by determining the deviation standard and
applying a correction (or calibration) factor

Configuration: a general term applied to the node indicating how it is set up for data
acquisition. It includes settings such as sampling mode and rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values.

Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to Greenwich Mean Time (GMT).

Cycle Power: a command transmitted to the node to reboot it, either through a hardware or
software switch

Data Acquisition: the process of collecting data from sensors and other devices

Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer

DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.
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EMI: Electromagnetic Interference is an inductive or radiated disturbance that can create
signal degradation on electrical signals, including loss of data.

ESD: Electrostatic Discharge is the sudden flow of electricity that can occur between two
charged objects of different potential that come in contact or in close proximity of each other.
Static electricity is a common source of ESD.

Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system. It includes device operation commands, conditions, memory allocation, and
many other tasks.

Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a “base station”.

Host (computer): The host computer is the computer that orchestrates command and control
of the attached devices or networks.

LED: Light Emitting Diode is an indicator light that is used in electronic equipment.

LOS (Line of Sight): is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network. As stated, it means the antennas are in
view of each other with no obstructions.

LXRS®:Lossless Extended Range Synchronized is the proprietary LORD MicroStrain® data
communications protocol used in the wireless sensor network.

NIST: The National Institute of Standards and Testing is a nationally-accepted organization for
testing and calibration of technological devices.

Node: The node is the wireless transceiver that the sensor(s) is connected to, providing
communication with the gateway. The G-Link® -LXRS®, V-Link® -LXRS®, and SG-Link® -
LXRS® are examples of nodes manufactured by LORD MicroStrain®.

Node Tester board: The Node Tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test their functionality.

Offset: When describing a mathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis. The equation of a straight
line is: y = mx+b, where xis the x-axis coordinate, yis the y-axis coordinate, mis the slope and
bis the offset.
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Oversampling: In signal processing, oversampling is a technique used to achieve increased
signal resolution and better noise immunity by recording readings at a higher frequency than
the output of the device being measured. In analog-to-digital conversion, the higher the
oversampling rate, the better the recreated analog signal.

Packet: unit of sampled data

Ping: a byte transmitted by the gateway to the node. The node responds by echoing the byte,
indicating communication exists between the node and gateway.

Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction

Read/Write EEPROM: commands transmitted to the node to read or write parameters stored
in the node’s operating system

Real Time Clock (RTC): a computer clock that keeps track of the current time

Resolution: in digital systems, the resolution is the number of bits or values available to
represent analog values or information. For example, a 12-bit system has 4,096 bits of
resolution and a 16-bit system has 65,536 bits.

RFIl: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.

RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. It is measured in decibels with reference to 1 milliWatt (dBm).

RS232: a serial data communications protocol

Sensor: a device that physically or chemically reacts to environmental forces and conditions,
producing a predictable electrical signal

Sleep: a command transmitted to the node to put it into sleep configuration
Sampling: the process of taking measurements from a sensor or device

Sampling Mode: the type of sampling that is being utilized, such as event-triggered,
continuous, or periodic. The nodes have several sampling modes that employ these types of
sampling.

Sampling Rate: the frequency of sampling
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Slope: When describing a mathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph. The equation of a straight line is: y = mx+b,
where xis the x-axis coordinate, yis the y-axis coordinate, mis the slope, and bis the offset.

Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the acquired data is transmitted to the gateway and
software. The data is not written to non-volatile memory during streaming. Streaming can
either be finite (have a user defined start and end time) or continuous (continued until the power
is cycled on the node).

Synchronized Sampling: a sampling mode that automatically coordinates all incoming node
data to a particular gateway. This mode is designed to ensure data arrival and sequence.

Transmission rate: the number of data packets per transmission window, measured in
seconds. Depending on the sampling mode and settings it will be between 1 and 64
packets/second.

Transmission window: the time allowed for one data transmission at the automatically
determined transmission rate

USB: Universal Serial Bus, a serial data communications protocol

WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure, and strain.
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